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Introduction
eFLOW Extract is an autonomous eFLOW application for automated processing and checking of incoming

invoices.

In the standard version, eFLOW Extract is pre-configured in such a way that it can generally be deployed at

once and integrated into existing systems in a short space of time. eFLOW Extract can also be adapted to

your own particular requirements. The open programming interfaces to eFLOW and eFLOW Extract enable

you to independently extend the free-form rules, to compile new validation functions and make other

adaptations to the workflow.

This guide provides a basic overview of the eFLOW Extract application and explains how to perform the

most common configuration tasks required for implementing an eFLOW Extract project. It is not intended as a

comprehensive guide to eFLOW Extract.

Application overview
The diagram below shows the standard eFLOW Extract application flow and stations.

Input stations

By default, eFLOW Extract provides the following input stations to capture invoice documents.

Station Purpose

Scan Imports invoices from scanned paper documents.

ePortal Imports invoices from emails. Email attachments are converted from the original format.

Collect Imports invoices from the local file system.
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Recognize station

The Recognize station identifies and records data from the imported invoices. It also applies recognition

rules to find the most likely candidates for field values, and performs validations to check and complete

recognized data. Validation and completion can draw on a reference database containing master data and

transaction data extracted from ERP systems.

Invoices that are fully recognized and validated move directly to the PreExport station. Invoices that could not

be fully recognized or that did not pass the validation checks move to the Validate station for manual

processing.

Validate station

The Validate station is a manual station in which typists can correct and complete the fields. Users can

access the station via a thick client installed on a PC or via a thin client in a web browser. eFLOW Extract

provides lookup tables in which typists can search for the relevant field values. The thick client also provides

a learning feature, which enables typists to manually teach the system how to find the correct field values. If

typists are unable to correct or complete a field or an entire invoice, they can mark it as an exception, which

can be handled by a more qualified user in the Escalate station.

Escalate station

The Escalate station is a manual station in which users can process collections that have been marked with

exceptions in the Validate station. It provides similar functionality to the Validate station.

PreExport station

The PreExport station prepares the data for transfer to connected ERP systems. It performs activities such as

data normalization (for example, converting formats). It is also responsible for dynamic learning and the

preparation of statistics.

Deliver2ERP station

The Deliver2ERP station exports data to connected ERP systems. It also provides an interface for importing

master data and transaction data from the ERP systems into the eFLOW Extract reference database.

Clean station

The Clean station holds invoices that have already been exported to the ERP systems. The Clean station can

also be used to save a backup of the invoices before they are finally deleted from eFLOW Extract. The Clean

station can be configured to finally delete invoices that are older than a specified number of days.
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Basic concepts
This section explains some basic terms and concepts that you should be familiar with when implementing

eFLOW Extract.

Invoice types/Document types

Every invoice has an invoice type. eFLOW Extract differentiates the following types of invoices:

n MM: Invoices with reference to a purchase order.

An invoice is identified as an MM invoice if a purchase order number is recognized on the image. Invoice

line items can be matched to the purchase order line items. The term MM is derived from SAP and stands

for Materials Management.

n FI: Invoices without reference to a purchase order.

Typically, these are invoices for services rather than goods. Only header information is captured, no line

items. The term FI is derived from SAP and stands for Financial Accounting.

n FIP: Invoices without reference to a purchase order, but with line items.

Typically, FIP invoices are issued when there is a need to assign accounting information to individual

items. They are usually enabled for specific suppliers only. The term FIP is derived from FI + Positions.

Every invoice also has a document type, which is usually an Invoice or a Credit note, but could also be

another type, such as a Down Payment. The document type is identified and assigned during recognition

based on predefined keywords.

Key fields

Field values can be located in one of the following locations:

n Header fields: Fields that apply to the invoice as a whole, such as the supplier, invoice date, invoice

number, document type, total amount, tax amount, tax rate, or currency.

n Line item fields: Fields that apply to individual items of the invoice, such as the item description, quantity

or unit price.

The table below lists the main fields used in eFLOW Extract. You can add additional fields. See Custom

fields for more information.

Header fields Line items (MM) Line items
(FIP)

Company code Purchase order number Quantity

Receiver name Position Unit of

measure

Supplier ID Quantity Unit price
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Header fields Line items (MM) Line items
(FIP)

Supplier name Unit of measure Description

Supplier street Unit price Identifier

Supplier postal code Article number Discount

Supplier city Description Total

amount

Supplier VAT ID Discount Cost center

Supplier tax number Total amount GL account

Supplier bank sort code VAT amount

Supplier bank account number Delivery note number

Supplier IBAN

Document type

Invoice date

Invoice number

Purchase order number

Delivery note number

Net amount

Discount (Before Tax)

Discount (After Tax)

VAT rate

VAT amount

Total amount
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Header fields Line items (MM) Line items
(FIP)

Currency

Additional Cost1 (before tax)

Additional Cost2 (before tax)

Recognition rules and validations

For each field, rules are defined to enable the eFLOW Extract Recognition workflow to identify the field on

invoices and find likely candidates for the field value, including:

n Language

n Keywords, such as Invoice Date or Invoice Number

n Topographical rules, such the position on the invoice and relative positions between fields

n Logical rules, such as the calculation of totals

n Masks and regular expressions

n Field groups and tables

n Checks against reference data, such as vendor master data or purchase order data

n Validations

Validations are also applied after recognition and in the Validate station to check and complete field values.

eFLOW Extract provides a user interface, Design Extract, for defining recognition rules and validations.

Conditions

Conditions enable you to apply different configuration settings for different requirements, such as different

clients or company codes. In previous versions of eFLOW Extract, this was achieved by specifying a <Case>

or <Client> value in the relevant configuration parameters. The <Case> value or <Client> value defined the

conditions under which a specific configuration setting should be used.

In eFLOW Extract 5.2, conditions are no longer limited to clients and company codes; you can now define

conditions based on other values as well. eFLOW Extract provides a user interface, Design Extract, for

defining configuration settings and conditions. Design Extract provides a more flexible approach to defining

configuration settings and conditions, enabling greater granularity and reuse, eliminating redundancy,

reducing the need for additional coding, and facilitating the management of multiple environments. See Use

conditions for information on applying conditions to configuration settings.

The terms client and company code are derived from SAP; case is an eFLOW Extract term.

In the context of SAP, a client is a separate business entity maintaining its own master data.
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A company code is the smallest organizational entity for which a complete, self-contained accounting

system can be replicated (for example, a branch within a company). Company codes refer to receivers of

invoices, and are usually recognized based on the receiver address given on the invoice. A company code

may also be referred to using the SAP term BUKRS.

An eFLOW Extract case can be a client, a company code, or a combination of both.

Country packages

A country package is a set of configuration settings that applies for a specific country (that is, the vendor

company, not the receiver company), such as languages, layouts, keywords, regular expressions,

recognition rules, and validations. Installing country packages is part of the installation procedure.

Currently country packages are available for the following countries:

n Australia

n Austria

n Belgium

n Czech Republic

n France

n Germany

n Italy

n Japan

n Poland

n Portugal

n Spain

n United Kingdom

n United States of America

Reference data

eFLOW Extract can use supplier master data (such as address, bank and tax data) and transaction data (such

as purchase order or delivery note details) from external systems to recognize, validate and complete invoice

data. This reference data is also available to users in lookup dialogs in manual validation stations. Reference

data is not required for recognition, but using it can improve recognition results and the quality of the data.

See Reference data for more information.

Learning

eFLOW Extract provides a dynamic learning feature that enables the system to automatically recognize field

values based on previously processed invoices. When a field is recognized on an invoice, details of the field

value and position are written to a history table. When another invoice is processed, the system checks

whether a field candidate has a matching entry in the history table. Dynamic learning enables high levels of

recognition even without reference data, although it can also be used in conjunction with reference data.
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Users can also apply manual learning in the Validate station to "teach" the system how to find the correct field

values. Manual learning can be applied if dynamic learning does not succeed in recognizing a field value.

Installation
This step-by-step guide provides detailed instructions for installing eFLOW Extract.

eFLOW Extract provides a batch file for automated installation, which must be run on the machine on which

eFLOW is installed. You should only use the batch file if you have a single eFLOW server on which all

components will be installed. In complex environments with multiple servers, you should perform the

installation manually.

System requirements
n eFLOW 5.2 SP1 or higher must be installed. eFLOW Extract 5.2 does not run on eFLOW versions prior to

5.2 SP1. See the eFLOW Implementation Guide for information on installing eFLOW.

n The Abbyy license must be activated. To check whether the license is activated, in the folder C:\Program

Files (x86)\TIS\eFlow 5\OCRs\Abbyy\Bin, double-click the LicenseManager.exe file. If there are no

licenses, in the C:\Program Files (x86)\TIS\eFlow 5\OCRs\Abbyy\Bin folder, copy the .LocalLicense file

and paste it into the C:\Program Data\ABBYY\SDK\11\Licenses folder. Then double-click the

LicenseManager.exe file again and check that the license is active.

n Deliver2ERP must be included in the eFLOW installation. By default, Deliver2ERP is not selected for

installation when installing eFLOW, so you may need to run the eFLOW installation wizard again and

install Deliver2ERP retrospectively.

n If you plan to use the email import feature of eFLOW Extract, the ePortal station must also be installed.

See the ePortal Implementation Guide for information on installing ePortal.

n The SQL Server Agent Windows service is required to run an eFLOW Extract SQL job that deletes old

dynamic data. If your SQL version does not support SQL Server Agent, or if it is not permitted due to

IT constraints, contact the eFLOW Extract Product Manager.

Installation package
The installation package is provided as a ZIP file named Extract_Install. The file name includes the product

version, build and date.

Automated server installation
Most installation tasks are performed by the ExtractInstallerServer.bat file, but you must also perform a few

steps manually. During the automated installation, you will be prompted to confirm or provide information,

such as the SQL server connection string. All components are installed on the eFLOW server.
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Tasks performed by the batch file

The batch file performs the following tasks:

1. Copies the Extract-Data folder to the root of drive C.

eFLOW Extract uses the folder C:\Extract-Data\ by default for the import of reference data from ERP

systems.

2. Copies all files from the Bin folder to the C:\Program Files (x86)\TIS\eFlow 5\Bin folder.

3. Installs the web services.

The following web services are deployed as applications in IIS.

Web service Description

ExtractConnectionConfigProvider Required for establishing connections to the SQL

databases.

ExtractConditionProvider Required by the Design Extract configuration interface.

IRConfigurationProvider Required to connect the Web Validate station to the

eFLOW Extract configuration.

IRDataServicesProvider Required by Web Validate to provide access to lookups

and perform database validations against reference data.

WorkflowStatusTrackingService Required to pass the status of eFLOW Extract invoices to

eFLOW Control, the TIS automated invoice processing

add-on for SAP. See Pass the eFLOW Extract status to

eFLOW Control for more information.
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4. Installs the databases.

The following SQL databases are created automatically. By default, the [Prefix] is Extract (for example,

Extract_Conditions), but you can change this value during the installation.

If you use SQL authentication, only the SQL user needs permissions for the databases.

If you use Windows authentication, you must ensure that Scan and Validate station users have the

appropriate permissions for the databases (R - read-only, or RW - read-write), where these are required.

Database Scan Validate Purpose

[Prefix]_Conditions

[Prefix]_Conditions_

Modules

None R Contain data related to the parameters defined in

the Design Extract configuration interface.

[Prefix]_DynamicData

[Prefix]_DynamicLearning

[Prefix]_DynamicLearning

Analyzer

None None Contain data related to dynamic learning.

[Prefix]_FieldLearning None RW Contains data related to manual learning.

[Prefix]_RefDB None RW Contains reference data used in validation and

completion. See Reference data.

[Prefix]_SapCache None None Temporary database for reference data. See

Reference data.

[Prefix]_Stats RW None Contains statistical data for reporting.

[Prefix]_Workflow Contains eFLOW related data.

See the eFLOW documentation for information

on required permissions.

5. Installs the application cab file. By default, the application name is Extract, but you can change this

value during the installation.

6. Installs country packages.

A confirmation message is issued when the installation has been successfully completed.

Note: Error messages may be displayed during installation, but as long as the installation continues,

these messages can be ignored.
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Installation procedure

This procedure should be performed with the user account that was used to install eFLOW.

Important: If the C:\Program Files (x86)\TIS\eFlow 5\Bin folder already exists on the eFLOW server, make

sure that the folder and all its files are not set to read-only before beginning the installation.

1. Copy the file Extract_Install.zip to the server on which eFLOW is installed and unzip it.

2. Run the ExtractInstallerServer.bat file from the command prompt:

a. In the Extract_Install folder, select File > Open command prompt > Open command prompt as

administrator.

b. Type ExtractInstallerServer.bat.

During the installation, you will be prompted to provide the following information:

n The prefix to use for creation of the SQL databases.

n Your SQL server connection string. This is required to create the databases.

n Whether you want to use Windows or SQL authentication to connect to the SQL server. If you choose

SQL, you must also provide the logon credentials.

n The name of the application.

n Which country packages you want to install. We recommend installing all country packages and

activating only the packages that you need when you create your configuration profile in Design

Extract. See Create a configuration profile for more information.

Note: The Japanese country package has some additional requirements. See the Japanese

Country Package Implementation Guide for more information.

3. In the setup folder of the application (for example, C:\ProgramData\TIS\eFLOW 5\AppData\Server\

[ApplicationName]Setup), in the file ExtractSettingsGlobal.appconfig, specify the default case. If you

change configuration settings in Design Extract, you also need to edit the ProfileContextName and

Deactivation ProfileContextName properties. See Create a configuration profile for more information.
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4. Make sure that the SQL Server Agent Windows service is running. This is required to run an

eFLOW Extract SQL job that deletes old dynamic data.

Automated client installation
The client installation on the eFLOW server is performed automatically as part of the automated server

installation. The following procedure is therefore only required for client workstations on which

eFLOW Extract stations will run.

Important: This procedure must be performed with the user account that was used to install eFLOW. If

the C:\Program Files (x86)\TIS\eFlow 5\Bin folder already exists on the eFLOW server, make sure that the

folder and all its files are not set to read-only before beginning the installation.

For each client workstation:

1. Copy the file Extract_Install.zip to the client and unzip it.

2. Run the ExtractInstallerClient.bat file.

This batch file copies all files from the Bin folder to the C:\Program Files (x86)\TIS\eFlow 5\Bin folder.

If you use Windows authentication, you must ensure that Scan and Validate station users have the

appropriate permissions for the databases. See Tasks performed by the batch file.

Manual server installation
To manually install eFLOW Extract on the eFLOW server, complete the following steps. This procedure

should be performed with the user account that was used to install eFLOW.

Important: If the C:\Program Files (x86)\TIS\eFlow 5\Bin folder already exists on the eFLOW server, make

sure that the folder and all its files are not set to read-only before beginning the installation.

1. Copy the file Extract_Install.zip to the server and unzip it.
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2. Use the eFLOW Administrate module to install the ExtractDemo.cab file located in the Cab folder:

a. In eFLOW Administrate, select File > New Application.

b. Enter a name for the application and in the Application archive field, browse to and select the cab

file.

3. Copy all files from the Bin folder to the C:\Program Files (x86)\TIS\eFlow 5\Bin folder.

4. Copy the Extract-Data folder to the root of drive C.

eFLOW Extract uses the folder C:\Extract-Data\ by default for the import of reference data from ERP

systems. If you copy this folder to a different location, you must change the path accordingly in the

transformation package. See Transformation Package Designer.

5. Install the web services:

a. If you are not installing the web services on the eFLOW server, copy the WebServices folder to the

web server.

b. In the WebServices folder, double-click the 00_InstallWebServices.bat file.

The following web services are deployed as applications in IIS.

Web service Description

ExtractConnectionConfigProvider Required for establishing connections to the SQL

databases.

ExtractConditionProvider Required by the Design Extract configuration

interface.

IRConfigurationProvider Required to connect the Web Validate station to the

eFLOW Extract configuration.

IRDataServicesProvider Required by Web Validate to provide access to

lookups and perform database validations against

reference data.

WorkflowStatusTrackingService Required to pass the status of eFLOW Extract

invoices to eFLOW Control, the TIS automated

invoice processing add-on for SAP. See Pass the

eFLOW Extract status to eFLOW Control for more

information.
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c. In the setup folder of the application (for example, C:\ProgramData\TIS\eFLOW 5\AppData\Server\

[ApplicationName]Setup), open the ExtractConnectionConfigProvider.appconfig file and edit the

EndpointAddress property to point to the web server on which the web services are installed:

EndpointAddress = new EndpointAddress("http://[YourServer]/ExtractConnectionConfigProvider/

Configuration.ConfigProvider.svc")

d. In the setup folder, open the ConfigConditioning.appconfig file and edit the <Address> parameter to

point to the web server on which the web services are installed:

<Address>http://[YourServer]/ExtractConditionsProvider/

ConditioningEntitiesService.svc/</Address>

Note: If you want to use a secure connection to the web services, specify https instead of http in the

address parameters. In the ExtractConnectionConfigProvider.appconfig file, change the Binding =

new BasicHttpBinding parameter to Binding = new BasicHttpsBinding. You must also configure IIS to

use HTTPS binding; see the IIS documentation for information on how to do this.

6. Install the databases:

a. If you are not installing the SQL databases on the eFLOW server, copy the Databases folder to the

SQL server.

b. In the Databases folder, change the details in the batch file 00_run_Extract_scripts_SQL_Auth.bat or

00_run_Extract_scripts_Windows_Auth.bat, depending on whether you connect to the SQL database

using SQL authorization or Windows authorization.

The names of the databases are prefixed with the value of the set DB_PREFIX parameter. By

default, this is Extract_ (for example, Extract_Conditions), but you can change it.

If you use SQL authentication, you must specify the connection details.

c. Run the batch file.
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The following SQL databases are created automatically.

If you use SQL authentication, only the SQL user needs permissions for the databases.

If you use Windows authentication, you must ensure that Scan and Validate station users have the

appropriate permissions for the databases (R - read-only, or RW - read-write), where these are required.

Database Scan Validate Purpose

[Prefix]_Conditions

[Prefix]_Conditions_

Modules

None R Contain data related to the parameters defined in

the Design Extract configuration interface.

[Prefix]_DynamicData

[Prefix]_DynamicLearning

[Prefix]_DynamicLearning

Analyzer

None None Contain data related to dynamic learning.

[Prefix]_FieldLearning None RW Contains data related to manual learning.

[Prefix]_RefDB None RW Contains reference data used in validation and

completion. See Reference data.

[Prefix]_SapCache None None Temporary database for reference data. See

Reference data.

[Prefix]_Stats RW None Contains statistical data for reporting.

[Prefix]_Workflow Contains eFLOW related data.

See the eFLOW documentation for information

on required permissions.

7. Install country packages:

In the Countries folder, double-click the corresponding batch file for each country package you want to

install. For example, double-click Country_USA_Import.bat to install the United States country package.

Alternatively, double-click ImportAllCountryPackages.bat to install all available country packages. We

recommend installing all country packages and activating only the packages that you need when you

create your configuration profile in Design Extract. See Create a configuration profile for more

information.

Note: The Japanese country package has some additional requirements. See the Japanese Country

Package Implementation Guide for more information.
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8. Set the database connection strings for the ExtractConnectionConfigProvider:

a. In the C:\inetpub\wwwroot\ExtractConnectionConfigProvider folder, open the Configurations.XML

file.

b. Edit the database connection strings to connect to your SQL server. If you changed the DB_PREFIX

value in the database installation batch file, adjust the Initial Catalog value accordingly.

9. Set the database connection strings for the ExtractConditionsProvider:

a. In the C:\inetpub\wwwroot\ExtractConditionsProvider folder, open the Web.config file.

b. Edit the database connection strings to connect to your SQL server.If you changed the DB_PREFIX

value in the database installation batch file, adjust the Initial Catalog value accordingly.

10. In the setup folder, in the file ExtractSettingsGlobal.appconfig, specify the default case. If you change

configuration settings in Design Extract, you also need to edit the ProfileContextName and Deactivation

ProfileContextName properties. See Create a configuration profile for more information.

Manual client installation
Important: This procedure must be performed with the user account that was used to install eFLOW. If

the C:\Program Files (x86)\TIS\eFlow 5\Bin folder already exists on the eFLOW server, make sure that the

folder and all its files are not set to read-only before beginning the installation.

For each client workstation:

1. Copy the file Extract_Install.zip to the client and unzip it.

2. Copy all files from the folder Bin to the C:\Program Files (x86)\TIS\eFlow 5\Bin folder.

If you use Windows authentication, you must ensure that Scan and Validate station users have the

appropriate permissions for the databases. See Manual server installation.

eFLOW Extract Web Validate
installation
eFLOW Extract Web Validate enables users to correct and complete fields that were not correctly recognized

or that did not pass validations in the Recognize station. It is very similar to the standard eFLOW Web

Validate station, but includes features specific to invoice processing.

System requirements
n eFLOW 5.2 SP2

n eFLOW Extract 5.2 SP1
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Installation files
The eFLOW Extract Web Validate installation files are located in the eFLOW Extract installation folder in the

Optional Components/Web Validate folder, which has the following subfolders:

Folder Description

Deployed at IIS Contains the subfolder WebValidate with the files required for installing

Web Validate.

DynamicDataServiceCreator-

Tool

Contains a tool to automatically create a new data service when you

make changes to the application, such as adding new fields, or if you

use multiple reference databases.

Installation procedure
This section explains how to install Web Validate.

Install eFLOW Web Validate

Make sure that the standard eFLOW Web Validate is already installed.

See the eFLOW Web Stations Implementation Guide for information on installing eFLOW Web Validate.

Install Web Validate

1. In the eFLOW Extract installation folder, go to the OptionalComponents/WebValidate/Deployed at

IIS/WebValidate folder and copy all files to the C:/inetpub/wwwroot/WebValidate folder. Select to replace

existing files when prompted.

2. In the eFLOW Extract installation folder, go to the Optional Components/Web Validate folder and run the

batch file copy webcompletion-external binaries.cmd.
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3. In the C:/inetpub/wwwroot/WebValidate/Scripts/Customization folder, open the

IRConnectionConstants.js file and edit all strings to connect to the server on which Web Validate is

installed.

4. In the C:/inetpub/wwwroot/ExtractConnectionConfigProvider folder, open the Configurations.xml file and

edit all occurrences of the property DataServiceUrl to connect to the server on which Web Validate is

installed.
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Configuration
This section explains how to configure the web services to connect to the ExtractSettingsGlobal.appconfig

file and the eFLOW Extract RefDB database.

Note: These steps are only necessary if you assigned your own application name during the

eFLOW Extract installation.

IRConfigurationProvider

1. In the folder C:/inetpub/wwwroot/IRConfigurationProvider, open the Web.config file.

2. In the <appSettings> section, in the first three lines, replace Extract with the name of your application.

<appSettings>

<add key="YourExtractApplicationName" value="ExtractSettingsGlobal.appconfig" />

<add key="YourExtractApplicationName.PM.DefaultRegex" value="(BUKRS='\d{3,5}')|(BUKRS='.{3,5}')" />

<add key="YourExtractApplicationName.PM.BukrsQualifier" value="BUKRS" />

3. (Optional) If you have an additional project configuration file, add this file to the end of the first line,

separated by a semi-colon from ExtractSettingsGlobal.appconfig.

<add key="YourExtractApplicationName"

value="ExtractSettingsGlobal.appconfig;ExtractSettingsYourProject.appconfig " />

IRDataServices

1. In the folder C:/inetpub/wwwroot/IRDataServicesProvider, open the Web.configfile.

2. Edit the <connectionStrings> section to connect to your application’s RefDB.

<add name="RefDb" connectionString="Data Source=.;Initial Catalog=YourExtractApplicationName_
RefDB;User id=SQLUserID;Pwd=SQLUserPassword" providerName="System.Data.SqlClient" />

Test
1. Open the web browser and enter [YourServer]/WebValidate in the address line.

2. The Web Validate Sign in page should be displayed.

3. Enter the user name and the password and click Next.

4. Select your application and a station and click Next.
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Configuration overview
This section provides an overview of configuring eFLOW Extract.

Configuration files
Configuration is either done in:

n The Design Extract user interface. Most configuration tasks can be performed in Design Extract.

n .appconfig configuration files located in the setup folder of the application, for example,

C:\ProgramData\TIS\eFLOW 5\AppData\Server\[ApplicationName]\Setup. The main configuration file is

ExtractSettingsGlobal.appconfig, which you can edit with the eFLOW Extract configuration editor.

Design Extract
Design Extract provides an interface for defining recognition rules to find the most likely candidates for field

values, and validations to check and complete recognized or manually entered data. In previous versions of

eFLOW Extract, this was done in the ConfigRecognitionCandidateValidation.appconfig or

ValidationConf.xml file, and the IRSettingsGlobal.appconfig file.

Design Extract also enables you to create conditions to apply different configuration settings for different

requirements. In previous versions of eFLOW Extract, this was achieved by specifying a <Case> or <Client>

value to the relevant configuration parameters. With Design Extract, you can now define conditions based on

other values as well.

Open Design Extract

We recommend creating a shortcut to provide easy access to Design Extract.

On the Windows desktop, create a new shortcut to the file TiS.DevGER.Shared.Conditioning.Client.UI.exe"

in the folder …\TIS\eFlow 5\Bin.

After starting Design Extract, click the Connect button at the bottom of the screen.

After the connection has been established, Connection appears at the bottom right of the screen.
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Design Extract configuration

Configuration is done in the following tabs.

Profiles tab

In this tab, you create configuration profiles.

A profile provides the context for the configuration settings and conditions. For example, a profile may

represent a specific customer or project, or a subdivision of a customer or project, such as separate

configuration settings for the test system and the production system.

Design Extract provides a default profile, whose settings are used if no other profile is defined.

If you need to make changes to the configuration settings or specify conditions, you should not change the

default profile, but create your own profile to provide the context for these specific settings. When you add a

setting, you assign your profile to this setting.

If you need to deactivate a standard setting, you must create a deactivation profile, then assign it to the

setting.

See Create a configuration profile for detailed information on working with profiles.
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Conditions tab

In this tab, you create conditions.

Conditions enable you to apply different configuration settings for different requirements.

Design Extract provides predefined conditions for specific countries and languages. It also provides sample

conditions for client and company code in the Samples folder, which you use as a basis to create your own

conditions.

You can combine conditions in condition sets and assign these sets to recognition rules in Design Extract,

and also to parameters in the ExtractGlobalSettings.appconfig file. When you assign a condition set to a

recognition rule or parameter, the rule or parameter settings are only applied if the condition is fulfilled.

See Use conditions for detailed information on working with conditions.
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Module tab

In this tab, you define approximations (keywords), regular expressions, normalizations, recognition rules, and

properties. Regular expressions and normalizations can be defined centrally here, and then applied as

needed to recognition rules in Design Extract, or to validations in the ExtractSettingsGlobal.appconfig file.

Properties define general settings, as well as settings for import, export and recognition.

See the following topics for examples of using these modules:

n Add keywords

n Define the PO format

n Define VAT rates

Configuration editor
For easy editing of configuration files, eFLOW Extract provides an editor. You can also edit the files in any

other editor, such as Notepad, but it is recommended that you use the eFLOW Extract editor.

Open the configuration editor

We recommend creating a shortcut to provide easy access to the configuration editor.
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1. On the Windows desktop, create a new shortcut to the file TiS.DevGER.Shared.Configurator.exe in the

folder …\TIS\eFlow 5\Bin.

2. Right-click the shortcut and select Properties.

3. In the Target field, add –dev=4 at the end of the path, then click OK.

4. Double-click the shortcut.

Working with the configuration editor

1. To open a configuration file, select Menu > Open.

2. Expand the nodes until the parameter you want to edit is displayed.

You can also press CTRL + F or select the menu item Edit > Find to search the file.

3. Select the parameter.

4. Move the mouse to the right of the dialog box, or click the Edit button .
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5. Edit the values displayed on the right of the dialog box.

This area is hidden when you move the mouse to the left. To prevent this area from being hidden, click

the Dock/Undock button .

Common configuration tasks
The following are the most commonly performed configuration tasks when implementing eFLOW Extract.

These tasks are explained in detail in the following sections.

Configure invoice and attachment separation

Configure reference data import

Configure data export to the ERP system

Create a configuration profile

Add keywords

Define the PO format

Define VAT rates

Define supplier-specific settings

Define FIP suppliers

Add a custom field

Pass the eFLOW Extract status to eFLOW Control in SAP
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Invoice and attachment separation
You must define how invoices are separated from one another in the eFLOW Extract Scan and Collect

stations. Some pages of an invoice document may not actually contain any invoice-relevant information. For

example, utility invoices often contain the invoice data on the first page, with a detailed breakdown of the

charges on the following pages. Pages containing non-relevant data that does not require recognition should

therefore be identified as attachment pages and separated from the invoice itself.

Invoices and attachments are usually separated by barcodes that appear either on the documents

themselves, or on a separate page inserted before each invoice or attachment. eFLOW Extract can extract

meta data from the barcode, such as a client or company code, and assign this data to collections as user

tags.

Define barcode separation
You must define the barcodes used for invoice and attachment separation in the Scan and Collect stations,

and in Design Extract.

Definition in Scan or Collect

1. Open the Scan or Collect station and click the Configure button .

2. In the configuration tree, click on Batch Separators > Software Separators, then click the Barcode
button.
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3. Under Barcode Types, select the barcode type that will appear on the invoices or attachments. If you do

not know the barcode type, select Auto.

The Separation action should be set to None.

4. Click the Add button.

Definition in Design Extract

In the Module tab, click Properties, then navigate to the appropriate folder:

n For invoice separation: SettingsImport > Barcode > Separation

n For attachment separation: SettingsImport > Attachment > Separation

Then set the properties listed in the table below. To set a property:

1. Click on the property in the Separation or Attachment folder.

2. Click the Add New Row button .

3. Enter the value.
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4. In the Profile list, select your configuration profile.

5. (Optional) To restrict the settings to a specific country, language or condition, select a value in the

Countries, Languages or ConditionSets list. For example, you can define different settings for the

Scan and Collect stations by assigning the IsStation_Scan and IsStation_Collect condition sets. See

Use conditions for more information.

6. If default property settings are defined, in the Profile list, select the standard Deactivation profile to

deactivate these default settings.

7. Click the Save button .

Property Value

Enabled true

BarcodeType This must be exactly the same barcode type that you specified in the Scan or

Collect station configuration.

Barcode Regular expression that defines the barcode format.

BehaviorOnMatch Only required if the barcode appears on a separate page.

Enter the appropriate value to specify what happens to the barcode page:

0: None

1: Custom

2: Set page as attachment

3: Set page and following pages as attachment

4: Set page and following pages as attachment, force remove

5: Remove page from collection

6: Remove page and following from collection

7: Remove page from collection set page and following as attachment

8: Remove page from collection set page and following as attachment, force

remove

Define meta data extraction
In Design Extract, in the Module tab, click Properties. Navigate to the SettingsImport > Barcode >

ExtractInfo folder.
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Then set the properties listed in the table below. To set a property:

1. Click on the property in the ExtractInfo folder.

2. Click the Add New Row button .

3. Enter the value.

4. In the Profile list, select your configuration profile.

5. (Optional) To restrict the settings to a specific country, language or condition, select a value in the

Countries, Languages or ConditionSets list. For example, you can define different settings for the

Scan and Collect stations by assigning the IsStation_Scan and IsStation_Collect condition sets. See

Use conditions for more information.

6. If default property settings are defined, in the Profile list, select the standard Deactivation profile to

deactivate these default settings.

7. Click the Save button .

Property Value

Enabled true

BarcodeType This must be exactly the same barcode type that you specified in the Scan or

Collect station configuration.

Info-Mappings Value: Regular expression that defines which part of the barcode contains the

information that is to be extracted.

Mapped value: The type of information to extract, such as $1 Client.

PageIndexExpected

Reference data
eFLOW Extract can use reference data such as supplier master data and transaction data from external

systems to recognize, validate and complete invoice data. This reference data is also available to users in

lookup dialogs in manual validation stations. Reference data is not required for recognition, but using it can

improve recognition results and the quality of the data.

Reference data is stored and updated in a reference database (RefDB) on an MS SQL server. The

Deliver2ERP station imports the reference data from connected ERP systems into the eFLOW Extract

reference database. If eFLOW Extract is used with SAP, the reference data is first imported into the

SAPCache database and then transferred to the eFLOW Extract reference database.
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Receiver data is also used in validation and completion. This data is not imported from the ERP system, but

from a CSV file, which must be created and maintained manually.

As part of the import process, the eFLOW Extract Transformation Package performs tasks that are required

to prepare the reference data for use with eFLOW Extract, such as importing receiver data from the CSV file,

transferring data from the SAPCache database to the RefDB database, or merging all supplier data into a

single table.

The Transformation Package is scheduled using the Windows Scheduler.

Databases
eFLOW Extract uses the following SQL databases for reference data.

SAPCache database

The SAPCache database is used to receive and temporarily store data from connected SAP systems.

The tables in the SAPCache database also exist in SAP. The SAPCache table and column names are the

same as in the SAP tables. The data is transferred directly from the SAP tables into the SAPCache database

by the Deliver2ERP station.

Table Description

BNKA Contains supplier bank account relations with SWIFT code.

/TISA/TAP_

EXTR1

Defines the relationship between purchase orders and suppliers.

Should be filtered by a custom SAP report that writes only open items to a table named

/TISA/TAP_EXTR1. eFLOW Control provides the report /TISA/AP_EXTRACT_PO_

UPDATE for this purpose.

/TISA/TAP_

EXTR2

Contains purchase order line items.

Should be filtered by a custom SAP report that writes only open items to a table named

/TISA/TAP_EXTR2. eFLOW Control provides the report /TISA/AP_EXTRACT_PO_

UPDATE for this purpose.

/TISA/TAP_

EXTR3

Defines the relationship between delivery note numbers and purchase order line items.

Should be filtered by a custom SAP report that writes only open items to a table named

/TISA/TAP_EXTR3. eFLOW Control provides the report /TISA/AP_EXTRACT_PO_

UPDATE for this purpose.
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Table Description

LFA1 Contains information about suppliers, such as the address or the VAT ID.

Deliver2ERP downloads the entire table from SAP. If SPERR (blocked) or LOEVM (marked

for deletion) is set for a supplier in SAP, that supplier's data is not imported into the

eFLOW Extract reference database.

LFB1 Defines the relationship between company codes and suppliers.

Deliver2ERP downloads the entire table from SAP. If SPERR (blocked) or LOEVM (marked

for deletion) is set for a supplier in SAP, that supplier's data is not imported into the

eFLOW Extract reference database.

LFBK Contains suppliers' bank data.

TIBAN Contains supplier bank account relations with IBAN.

RefDB

The RefDB database is accessed directly by eFLOW Extract during validation and completion. It contains the

following tables.

Table Contents

EKKO Defines the relationship between purchase orders and suppliers.

EKPO Contains purchase order line items.

IRAccount Used to assign accounts to identifiers for FIP invoices. See FIP

configuration for more information.

IRDeliveryNoteNoPOPos Contains all data of delivery notes.

The transformation package merges the data from the SAPCache tables

ZEKBE and EKKO into this table.

eFLOW Extract accesses the delivery data via the RefDB view

vPositionsEKBESight, which joins the tables EKPO and

IRDeliverNoteNoPOPos.

IRFieldValueTemplates Contains default field values for suppliers. See Supplier specific settings

for more information.
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Table Contents

IRFIPMapping Defines suppliers as FIP suppliers. See FIP configuration for more

information.

IRReceiverAdressData Contains all receiver address data.

The transformation package imports this data from the Receiver.csv file.

IRSuppliersFullData Contains all supplier data.

The transformation package merges the supplier data from the SAPCache

tables LFA1, LFB1, LFBK, TIBAN and BKNA into this table. The table may

contain more than one entry per supplier if multiple supplier bank accounts

exist.

FDDBs

FDDBs are simple text files containing supplier and receiver data, such as addresses or bank information.

They are used during recognition to find the invoice receiver and supplier.

The Recognize station generates the FDDB files at runtime from the reference database. The files are stored in

the application setup folder, for example, C:\ProgramData\TIS\eFLOW 5\AppData\Server\

[ApplicationName]\Setup.

Configure reference data
The following steps are required to configure reference data. This procedure assumes that you are importing

reference data from an SAP system running eFLOW Control.

1. Modify the supplied Receiver.CSV file in the C:/Extract-Data/Runtime/Masterdata folder, adding your

own receiver address data.

Add each name and address in a separate line. Remember to add lines for variations that you expect

suppliers to use. For example, the following four lines refer to the same receiver, but with variations of the

name.
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2. Create an SAP report to restrict the PO and delivery data to open items only. The report should write

open PO items to the /TISA/TAP_EXTR2 table, and open delivery items to the /TISA/TAP_EXTR3 table.

In SAP, schedule the report to run at regular intervals, such as every night.

eFLOW Control provides the report /TISA/AP_EXTRACT_PO_UPDATE for this purpose. See the

eFLOW Control Implementation Guide for information on this report.

3. In the Deliver2ERP station, configure an external destination for reference data import.

4. Configure the transformation package to connect to your eFLOW Extract SQL databases and define the

FDDB location, then run the transformation package.

5. Create a task in Windows Task Scheduler to run the transformation package at regular intervals.

Deliver2ERP import configuration
To import reference data from an SAP system, you must configure an external destination in the Deliver2ERP

station. eFLOW Extract provides a preconfigured external destination for import from an SAP system running

eFLOW Control. If you need to connect to an SAP system running Maxpost, or to non-SAP systems, contact

the eFLOW Extract product manager.

Prerequisites

n Deliver2ERP was included in the eFLOW installation.

n An RFC user has been configured in the SAP system. Data exchange between eFLOW Extract and SAP

takes place via this RFC user. See Roles in the eFLOW Control and Resolve Implementation Guide for

more information.

n The latest SAP GUI for the SAP version that is used is installed on the eFLOW Server.

n The file ERPExportSetup.XML in the folder …Program Files\TIS\eFlow 5\Bin is not set to read-only.

Deliver2ERP writes the configuration settings to this file.

Configure the external destination

This procedure explains how to configure the external destination for import from an SAP system running

eFLOW Control.

1. In eFLOW Launch Pro, select the station Deliver2ERP.

2. On the Tools menu, select Configure.

3. Expand the External Destinations node and then the MDDownloadEflowControlDestination node.
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4. Click the Connectivity Settings node and enter the connection details for the SAP system.

In the Username and Password fields, enter the user name and password of the RFC user.

In the Host field, specify the host, port, password and server:

/H/[Host]/S/[Port]/W/[SAP router password]/H/[Server]

For example:

/H/123.456.78.123/S/3299/W/X$Pwd1/H/234.567.123.789
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5. Set the import schedule. By default, data is imported daily at midnight. You only need to set the schedule

if you wish to change the import frequency or time.

a. Expand the Cache Providers node and click on BNKA.

b. Click the Change Schedule button and specify how often the data should be imported, then click

OK.
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c. If prompted, enter the SQL server credentials and click OK.

d. Repeat these steps to set the schedule for all tables in the Cache Providers node.

6. Click the Save button on the toolbar.

Deliver2ERP creates tasks in the Windows Task Scheduler with scheduling settings corresponding to

those entered for the cache provider.

Note: The Deliver2ERP station must also be running in standby mode.

After these tasks run for the first time, corresponding database tables are created in the SapCache

database.
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7. As a final step, you must change some settings in the SapCache database in Microsoft SQL Server

Management Studio:

a. In the LFBK table, expand the Columns folder. Right-click the DataVersion column and select

Modify. Activate the Allow Nulls check box.

b. On the Tools menu, select Options. Open the Designers > Table and Database Designers

options and activate the Prevent saving changes that require table re-creation check box.

Transformation Package Designer
The TIS Data Transformation Package Designer performs tasks that are required to prepare the reference

data for use with eFLOW Extract, such as importing receiver data from the CSV file, transferring data from the

SAPCache database to the RefDB database, merging all supplier data into a single table, or transferring

supplier and receiver data to the FDDB files.

The executable for the Transformation Package Designer TiS.DevGER.Shared.Data.PackageDesigner.exe

can be found in the C:\Extract-Data\DTP Designer folder.

eFLOW Extract provides a preconfigured transformation package file in the C:\Extract-Data\Runtime folder

for SAP systems running eFLOW Control. This file contains all the steps required to transfer master and

transaction data to the appropriate eFLOW Extract database tables. You only need to make minor changes to

some of the tasks included in the package.
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Run the EFLOW Extract transformation package

1. In the C:\Extract-Data\Runtime folder, double-click the Transform Extract Master Data from

eFLOW Control.tpf file.

All tasks required to transfer the data are selected by default.
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2. If you changed the location of the Extract-Data folder during installation of eFLOW Extract, change the

location in the Transfer Receiver.csv to RefDb.IRReceiverAdressData task accordingly.

3. Click the Run button .

After running the package, check the SQL databases to ensure that the data has been transferred

successfully. You can also check the transformation package log file in the folder …TIS\eFLOW

5\Bin\Utilities\TisDatatransformations\DTP Designer\Log. To open this file, click the Open DTP log button

in the package designer.

Schedule the transformation package

Use the Windows Task Scheduler to schedule the transformation package to run at regular intervals to

update the eFLOW Extract databases with the latest data from the ERP system.

1. Start Windows Task Scheduler.

2. Right-click on Task Scheduler Library and select Create Basic Task.

3. In the Create Basic Task Wizard, enter a name and description for the task.
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4. Select a trigger and specify when the task should run, for example, daily.

5. Select the action Start a program.

6. In the Program/script box, enter the path to the Transformation Package Designer executable. For

example (make sure you include the quotes):

"C:\Extract-Data\DTP Designer\TiS.DevGER.Shared.Data.PackageDesigner.exe"

7. In the Add arguments (optional) box, enter the path to the transformation package. For example (make

sure you include the quotes and /ec):

“C:\Extract-Data\Runtime\Transform Extract Master Data from eFLOW Control.tpf” /ec

8. Click Yes when prompted to confirm the use of arguments.

9. Click Finish.
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Export to ERP
To export data from eFLOW Extract, you must configure an external destination in the Deliver2ERP station to

represent the external system. eFLOW Extract provides a preconfigured external destination for export to an

SAP system running eFLOW Control. If you need to connect to an SAP system running Maxpost, or to non-

SAP systems, contact the eFLOW Extract product manager.

Prerequisites
n Deliver2ERP was included in the eFLOW installation.

n An RFC user has been configured in the SAP system. Data exchange between eFLOW Extract and SAP

takes place via this RFC user.

n The latest SAP GUI for the SAP version that is used is installed on the eFLOW Server.

n The file ERPExport.XML in the folder ...\Program Files (x86\\TIS\eFlow 5\Bin is not set to read-only.

Deliver2ERP writes the configuration settings to this file.

Configure the external destination
1. In Design Extract, in the Modules tab, click Properties.

2. Expand the SettingsControl > SapConnectionParameters folder, then click

SapConnectionParameters.

3. In the Value field, enter the connection details for the SAP system to which the status will be passed.

NAME="MySapSystem" USER="MyUser" PASSWD="MyPw" CLIENT="100" LANG="EN"

SYSNR="00" ASHOST="SapServerAdress"

NAME refers to the name of the document port defined in Deliver2ERP. In the preconfigured external

destination, this is DPEflowControl.

USER and PASSWD refer to the user name and password of the RFC user.

4. In the Profile field, assign your project profile.

5. Click the Save button .

If you changed the location of the Extract-Data folder and chose an application name other than Extract
during installation, you must also perform the following steps:

1. In eFLOW Launch Pro, select the station Deliver2ERP.

2. On the Tools menu, select Configure.

3. Expand the nodes External Destinations > EflowControlDestination > Document Ports.

4. Click on the DPEflowControl port.
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5. In the XSL Transformation File and Dump Folder fields, change the path to point to the location of the

Extract-Data folder.

6. Expand the Form Export Settings node and click Extract\InvoiceReader\Invoice.

7. In the Application list, select the name of your application.

8. Click the Save button .

Create a configuration profile
Configuration profiles enable you to define configuration settings for specific requirements. For example, a

profile may represent a specific customer or project, or a subdivision of a customer or project, such as

separate settings for the test system and the production system.

Design Extract provides a default profile, whose settings are used if no other profile is defined.

If you need to make changes to the configuration, you should not change the default profile, but create your

own profile to provide the context for these specific settings. When you add a setting, you assign your profile

to this setting.

If you need to deactivate the standard settings, you must create a deactivation profile, then assign it to the

setting.
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Design Extract provides a project profile and a project deactivation profile that you can use, or you can create

your own.

Create a profile
1. In Design Extract, click the Profiles tab.

2. Click on the ProjectProfiles grouping, or click one of the following buttons to create a new grouping:

n Add Root Grouping : To create a new grouping at the top level of the tree.

n Add Rooting : To create a grouping below another grouping.

3. Click the Add Profile button .

4. Enter a name for the profile and click OK.

5. Add the countries and languages for the profile set by selecting each country or language and clicking

the Select button .

6. Click the Save button .

Create a deactivation profile
1. In Design Extract, click the Profiles tab.

2. Click on the ProjectProfiles grouping, or click one of the following buttons to create a new grouping:

n Add Root Grouping : To create a new grouping at the top level of the tree.

n Add Rooting : To create a grouping below another grouping.

3. Click the Add Profile button .

4. Enter a name for the profile and click OK. Make sure you include the word Deactivation in the profile

name so that you can easily recognize it as a deactivation profile.

5. Click the Save button .
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Add profiles to ExtractSettingsGlobal
You must specify in the ExtractSettingsGlobal.appconfig file which profiles eFLOW Extract should use. If you

do not add these properties, eFLOW Extract will use only the standard settings.

1. In the Configuration Editor, open the ExtractSettingsGlobal.appconfig file.

2. In the <GlobalSettings><ProfileContextName> and <Deactivation ProfileContextName> sections, enter

the name of your configuration profile and deactivation profile.

3. Save your changes.

Assign a profile to a configuration setting
1. Select the setting.

2. In the Profile field, select the profile to which the setting applies.

3. To deactivate a standard setting, select your deactivation profile.

See the following topics for examples of assigning profiles to configuration settings:

n Add keywords

n Define the PO format

n Define VAT rates

Add keywords
Keywords enable eFLOW Extract to recognize the invoice language, and to locate, extract and validate field

values on the invoice. eFLOW Extract provides a predefined list of keywords in various languages

(depending on the installed country packages), and you can add your own keywords.

Keywords can be mapped to a specific value that is entered as the field value when the keyword is found. For

example, in English, keywords such as BILL OF SALE can be mapped to the value INVOICE to identify the

document type as an invoice, or CREDIT MEMO can be mapped to the value CREDITNOTE to identify the

document type as a credit note.

Note: If you do not yet have a configuration profile, create one first.

To add keywords:

1. Open Design Extract.

2. In the Module tab, click Approximation.

3. Expand the appropriate folder. For example, to define a new keyword for a date, expand the Label folder

and then the Date folder.
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4. Click the label or value to which you want to add the keyword and then click the Add New Row button

.

5. In the Value field, enter the keyword, then click in the Languages field and select the languages for which

the keyword applies from the dropdown list.

6. In the Profile field, select your configuration profile.

7. Click the Save button .

Define the PO format
Design Extract provides the standard recognition rule template TemplateNumberPo_General for the

purchase order number format. If the receiver's purchase order numbers do not conform to the format defined

in this template, you must create a new recognition rule for the PO number format. Defining the PO format

involves the following steps.

1. Create a new recognition rule for the PO_Number header field.

2. Link this rule to the PO_Number_Candidate and Position_PO_Number fields. This saves you having

to define the same rule again for these fields.

3. Deactivate the default rules for PO number fields.

4. Create a normalization for the PO number field and deactivate the default normalizations.

Note: You must have already created a configuration profile and a deactivation profile. See Create a

configuration profile.

Create a new rule for the header PO number
1. In the Module tab, click Recognition Rules.

2. Expand the Fields folder, then click the PO_Number folder.

3. Click the Add new recognition rule button .

4. Enter a name for the rule and click OK.

5. In the Profile list, select your configuration profile.
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6. Enter the general settings. In the Replacements list, select Set NormalizerPO. This is a predefined

normalization set containing normalizations that remove blank spaces and superfluous characters.

Setting Value

Maximum number of words Maximum number of words allowed for the value to be considered

as a candidate.

Replacements SetNormalizerPO

This normalization set contains normalizations that remove blank

spaces and superfluous characters.

Expression Your regular expression to enable eFLOW Extract to find the

receiver's PO format. For example, ^(95|96)\d{8}$ finds PO

numbers that begin with 95 or 96 followed by 8 digits.

7. Enter the evaluation settings. Click the Add button to add a validation.

For example, add the regular expression ^(95|96)\d{8}$ to find PO numbers that begin with 95 or 96

followed by 8 digits.
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8. (Optional) Click the Add button to add another evaluation. For example, you can add a

second evaluation with the regular expression (95|96)\d{8}, which is less strict, and assign a lower

Positive Confidence value.

9. Click the Save button .

Link the template to other PO number fields
1. Click the PO_Number_Candidate folder and then click the Link recognition rule button .

2. Select the new rule you just created and click OK.

3. Repeat these steps for the Position_PO_Number folder.

4. Click the Save button .

Deactivate the default rules
1. In the PO_Number folder, click TemplateNumberPo_General.

2. In the Profile list, select your deactivation profile.

3. Click the Save button .

This automatically deactivates the standard rule for the PO_Number_Candidate and Position_PO_Number
fields.
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Create and deactivate normalizations
1. In the Module tab, click Normalization.

2. Expand the Fields folder and click PO_Number.

3. Click the Add New Row button .

4. Enter your regular expression for the PO number and check the Regex check box.

5. Enter the Value to replace the expression.

6. In the Profile field, select your configuration profile.

7. For each default normalization in the table, in the Profile field, select your deactivation profile.

8. Click the Save button .

Define VAT rates
By default, no VAT rates are activated in Design Extract. You must therefore activate the VAT rates to be used

in your project.

If you need to define your own VAT rates, the following steps are required:

1. Create a new rule for the VAT1 field.

2. Link this rule to the VAT2 and VAT13 fields.
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3. Create a new rule for VAT12 field.

4. Deactivate the default rules for the VAT1, VAT2, VAT12 and VAT13 fields.

Note: You must have already created a configuration profile and a deactivation profile. See Create a

configuration profile.

Activate VAT rates
1. In the Module tab, click Properties.

2. Expand the SettingsGeneral > SpecificVatRates folder, then click SpecificVatRates.

3. For each VAT rate that you will use, in the Profile field, select your configuration profile.

4. Optionally, select the countries and/or languages for which the VAT rates apply.

5. If a needed VAT rate is not listed, you can add it:

a. Click the Add New Row button .

b. Enter the VAT value.

c. In the Profile field, select your configuration profile.

6. Click the Save button .

Define new VAT rates
eFLOW Extract provides the standard recognition rule templates TemplateRateVatStandard_General and

TemplateRateVatCalculation_General for VAT rates. If you need to use a VAT rate that is not defined in

these templates, you must create a new recognition rule for the VAT rates.

Create a new rule for the VAT1 field

1. In the Module tab, click Recognition Rules.

2. Expand the Fields folder, then click the VAT1 folder.

3. Click the Add new recognition rule button .

4. Enter a name for the rule and click OK.

5. In the Profile field, select your configuration profile.

6. Enter the settings. In the Expression field, adjust the regular expression to find the VAT rates.

7. (Optional) Click the Add button to add another evaluation.

8. Click the Save button .
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Link the template to VAT2 and VAT13 fields

1. Click the VAT2 folder and then click the Link recognition rule button .

2. Select the new rule you just created and click OK.

3. Repeat for the VAT13 field.

4. Click the Save button .

Create a new rule for the VAT12 field

1. Expand the Fields folder, then click the VAT12 folder.

2. Click the Add new recognition rule button .

3. Enter a name for the rule and click OK.

4. In the Profile list, select your configuration profile.

5. Enter the settings. In the Expression field, adjust the regular expression to find the VAT rates.

6. (Optional) Click the Add button to add another evaluation.

7. Click the Save button .

Deactivate the default rules

1. In the VAT1 folder, click TemplateRateVatStandard_General.

2. In the Profile list, select your deactivation profile.

3. Repeat for the VAT2 and VAT13 fields.

4. In the VAT12 folder, click TemplateRateVatCalculation_General.

5. In the Profile list, select your deactivation profile.

6. Click the Save button .

Use conditions
Conditions enable you to apply different configuration settings for different requirements, such as different

clients or company codes.

Design Extract provides predefined conditions for specific countries and languages. It also provides sample

conditions in the Samples folder, which you use as a basis to create your own conditions.

Conditions are always grouped in condition sets, which you can then assign to configuration settings. These

settings are only used if the condition is fulfilled.
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Create a condition
The following procedure demonstrates how to define a condition for a specific company code. Design

Extract provides a template for a company code condition, which you can copy and adapt to your

requirements.

1. In Design Extract, in the Conditions Tab, click Condition.

2. Click the Samples folder, then click the Add Condition button .

3. Enter a name for the condition and click OK.

4. In the Samples folder, click BukrsIs1000 and click the Interpreter tab.

5. Copy the contents of the References box.

6. In the Samples folder, click on your new condition.

7. Click the radio button on the Interpreter tab, then paste the copied text into the References box.

8. Repeat these steps to copy the contents of the Using Declarations and Expression boxes.

9. In the Expression box of your new condition, change all instances of ("BUKRS") == "1000" to match

your company code, for example, change it to ("BUKRS") == "1234".

10. Click the Save button .

Create a condition set
1. In the Conditions tab, click Condition Set.

2. Click the TestSample folder, then click the Add condition set button .

3. Enter a name for the condition set and click OK.

4. In the Available Conditions list, expand the Samples folder.

5. Select your condition, then click the Select button .

The condition moves to the Selected Conditions list.

6. Click the Save button .

Apply a condition in Design Extract
1. In the Module tab, select the setting to apply the condition to.

2. Click in the Condition Sets field and select the condition set.

3. Click the Save button .
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Apply a condition in ExtractSettingsGlobal
1. Open the ExtractSettingsGlobal.appconfig file.

2. Locate the setting to which the condition will apply.

3. Add a new <Value Case> parameter with the value "ConditionSets([YourConditionSetName])", for

example:

<Value Case="ConditionSets(CompanyCodeIs1234)">true</Value>

4. Save the file.

Pass the eFLOW Extract status to
eFLOW Control in SAP
eFLOW Control is the TIS automated invoice processing add-on for SAP. It receives invoices from

eFLOW Extract.

You can configure eFLOW Extract to pass information about the status of invoices in the eFLOW Extract

workflow to eFLOW Control. eFLOW Control users can then see which invoice documents are currently

queued in each eFLOW station and view the invoice images. See the eFLOW Control documentation for more

information on eFLOW Control.

You set the configuration parameters in Design Extract.

Prerequisites
n eFLOW Extract 5.2 Service Pack 1

n eFLOW Control 5.2 Service Pack 3

n An RFC user has been configured in the SAP system. Data exchange between eFLOW Extract and SAP

takes place via this RFC user.

Define the SAP connection parameters
1. In the Module tab, click Properties.

2. Expand the SettingsControl > SAPConnectionParameters folder, then click

SAPConnectionParameters.
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3. In the Value field, enter the connection details for the SAP system to which the status will be passed.

NAME="MySapSystem" USER="MyUser" PASSWD="MyPw" CLIENT="100" LANG="EN"

SYSNR="00" ASHOST="SapServerAdress"

NAME refers to the name of the document port defined in Deliver2ERP. In the preconfigured external

destination, this is DPEflowControl.

USER and PASSWD refer to the user name and password of the RFC user.

4. In the Profile field, assign your project profile.

5. Click the Save button .

Activate workflow status tracking
1. In the Module tab, click Properties.

2. Expand the SettingsControl > ReportWorkflowProgress folder, then click

ReportWorkflowProgressEnabled.

3. Set the value to true.

4. (Optional) If the Recognize station runs on multiple machines, set the web service URL for each machine:

n Click ReportWorkflowProgressServiceUrl.

n For each additional machine that runs Recognize, click the Add New Row button and in the

Value field, enter the address of the WorkflowStatusTrackingService for that machine.

5. Click the Save button .

Supplier-specific settings
You can configure the following default values to use for specific suppliers:

n Route collections that pass all validations directly to the Deliver2ERP station.

n Set fixed values for fields or user tags.

n Specify a learning template for supplier identification.

n Define a format for date and amount fields.

n Define replacement rules for fields.

n Skip dynamic learning for the supplier.
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Edit supplier specific settings
1. In the eFLOW Extract Validate station, press F5 to open the Learning window.

2. Select the menu item Plugins > Template editor.

3. Enter the client (MANDT), company code (BUKRS) and supplier ID (LIFNR).

4. Enter the required values in the appropriate field. See the following sections for detailed information.

Note: All records in the editor require an entry in the LIFNR field, except those configured for direct

routing to export.

Set routing to the Deliver2ERP station
In the ExtractSettingsGlobal.appconfig file, in the section <Stations><Recognition><PostProcess>

<Routing><RouteDirect2Export>, you can specify for each invoice type whether collections are by default

sent directly to the Deliver2ERP station if all validations are passed.

You can override these settings for a specific client, company code or supplier.

In the Template Editor, in the RouteDirectToExport field, check the check box to allow, or uncheck to

disallow, direct export routing.
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Note: This is the only setting that does not necessarily require a specific supplier ID. For example, you

can disable direct routing for a specific client and company code, and the setting will apply to all suppliers

of the specified company code in the specified client.

Set fixed values for fields
You can force the content of a specific field to be set to a fixed value for a specific supplier, such as the

currency or the document type.

Enter the name of the field and the fixed value in the eFFieldName and eFFieldValue fields.

To overwrite the existing field value, check the check box the OverwriteExisting field.

Note: This is the only setting for which the OverwriteExisting field is relevant.

Set fixed values for user tags
You can force the content of a specific user tag to be set to a fixed value for a specific supplier. Typically, this

is used to enforce the invoice type.

Enter the name of the user tag and the fixed value in the eFCollectionUserTagName and eFFieldValue
fields.

Specify a learning template
You can specify a text-based learning template to use for identifying a specific supplier. The company code

must have been identified in advance. For information on creating a learning template, see the eFLOW Extract

Validate User Guide.

Enter the template name in the efTemplate field.

Define formats
You can define supplier-specific formats for date and amount fields.

1. Enter the name of the field in the eFFieldName field.

2. Enter the required values in the Normalization_ fields.

Field name Description

Normalization_

ExecuteSpecial

Determines how three digits after a decimal separator are interpreted. For

example:

Checked: 1.000 is interpreted as 1000

Cleared: 1.000 is interpreted as 1
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Field name Description

Normalization_LCID Specifies the LCID (Microsoft locale ID) for the field.

Normalization_

FormatString

Specifies the final format for dates and amounts.

Normalization_

Replaces

Specifies characters to replace in the field.

These settings override <Replace> settings for the field in the

ExtractSettingsGlobal.appconfig file.

Skip Dynamic Learning
If you do not want dynamic learning to be performed for the supplier, check the Skip Dynamic Learning
check box.

FIP configuration
By default, invoices that have no reference to a purchase order (FI invoices) are exported without line items.

There may be cases, however, where line items are required on an FI invoice in order to record accounting

information. Such invoices are known in eFLOW Extract as FIP invoices: FI + Positions.

If you expect to receive FIP invoices from a supplier, you must define that supplier as an FIP supplier. You

can then assign default account assignments that are added to the line items based on identifiers quoted on

the invoice, such as a mobile telephone number, a car registration number, and so on.

You must enable FIP in the Validate station.

Note: Users can also define FIP suppliers and account assignments in the Validate station. See the

eFLOW Extract Validate User Guide for more information.
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Configure FIP suppliers
To configure suppliers that send FIP invoices:

1. Open Microsoft SQL Server Management Studio.

2. Expand the Databases tree to display the eFLOW Extract RefDB database tables.

3. Right-click on the table IRFIPMapping and select Edit Top 200 Rows.

4. Enter the client, company code and supplier ID.

5. In the FIPositions field, enter 1.

Define account identifiers
1. In Microsoft SQL Server Management Studio, expand the Databases tree to display the eFLOW Extract

RefDB database tables.

2. Right-click on the table IRAccount and select Edit Top 200 Rows.

3. Enter the client, company code and supplier ID.

4. Enter the account identifier and the corresponding GL accounts and cost center.

Note: Validate users can also define account identifiers in the Validate station. See the eFLOW Extract

Validate User Guide for more information.
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Enable FIP in Validate
To enable FIP in the Validate station, in the file ExtractSettingsGlobal.appconfig set the

<Stations><Validate><FIPosition><Supported> property to true.

Custom fields
eFLOW Extract comes preconfigured with most of the fields required in a project, but you can also add

additional fields. Ten "extension" fields (Ext_1 to Ext_10) are provided for this purpose, which are fully

integrated in eFLOW Extract.

The following steps are required to use the extension fields.

Note: Recognition, validation and learning configuration is only required for fields that should be

recognized. Statistics configuration is only required if the field should be included in the eFLOW Extract

Statistics reports.

Add the field in Design Free
1. In eFLOW LaunchPro, select the eFLOW Extract application and the Design Free tool.

2. In the Select form dialog box, select the Flow and Form and then the appropriate Script. For example,

select the R_Ext1 script to add the Ext_1 field.

Note: You may need to first select the menu item File > Open to display the Select form dialog box.

3. Right-click on Groups and select New group. To change the group name, click twice on the group and

enter a new name.

4. Expand the gExtFields group, then drag and drop the field that corresponds to the selected script (for

example, Ext_1) into your new custom group.
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5. Enter the properties for the field. The Type must be Words group. See the Design Free User Guide for

more information on the field properties.

6. (Optional) If you need to connect your custom field to another previously recognized field (for example, to

specify the field's location in relation to the recognized field), create an injection group:

a. Add a new group, for example, gInjection_Ext_1.

b. Drag and drop the field that is to connect to your custom field into the injection group. Set the Type

value for the field to Words group and in the Validation DLL field, enter

"FreedomInvocationSharedValidation_Native.ValidateInjectedField".

c. Drag the injection group into your new custom group.

d. Add rules to define the relationship between the fields. See the Design Free User Guide for more

information.

e. Make sure that the injection group is located above your custom group in the Groups tree. Use the

Move object up or Move object down button to change the group's location.

7. Click the Save button .

Add the field to the layout in Design
Add the field to the Validate station layout using the Design module. See the Layout Designer User Guide for

information on how to add fields to layouts.

Configure field recognition
1. Open Design Extract.

2. In the Module tab, click Recognition Rules.

3. Click on the Fields grouping, then click the Add Grouping button .

4. Enter the name of the field, then click OK. The name must be exactly the same as in Design Free, for

example, Ext_1.

5. In the Module tab, click Properties.

6. In the SettingsRecognition > Freedom scripts > R_Ext_Enabled folder, click R_Ext_Enabled.

7. Click the Add New Row button .

8. Enter the name of the R_Ext script that you selected in Design Free, for example, R_Ext1.

9. In the Profile field, select your configuration profile.
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10. Click the Save button .

Configure field validation
1. In the Configuration Editor, open the ExtractSettingsGlobal.appconfig file.

2. In the section <Shared><Statics><Validations><Fields>, locate the field (for example, <Ext_1>) and

specify the validation properties, such as the required format, normalizations, dependent fields, and so

on.

3. Save your changes.

Configure the field for manual learning
1. In eFLOW LaunchPro, select the eFLOW Extract application and the Design Free tool.

2. Select the field and change the Validation DLL to "FreedomInvocationSharedFieldLearning_Native.

ValidateSchemaAndCandidateConfig". This is not mandatory, but is strongly recommended.

The standard validation DLL for extension fields is "FreedomInvocationSharedFieldLearning_Native.

ValidateSchemaOnly", which checks whether the field value lies in the same area as the user marked in

the Learning module. However, this validation only checks the rectangle, and not its contents. If more

than one value lies within the rectangle, it is not possible to identify the correct value without defining a

mask in Learning.

The "FreedomInvocationSharedFieldLearning_Native.

ValidateSchemaAndCandidateConfig" validation DLL checks both the rectangle and the required

format that is defined in Design Extract.

3. Click the Save button .

4. Open the ConfigFieldLearning.appconfig file in a text editor.

5. Add the field and enter the properties.

6. Save your changes.

Configure the field for dynamic learning
1. Open Microsoft SQL Server Management Studio.

2. Add the field to the history table. This ensures that history data is collected for the field.

a. Expand the Databases tree to display the eFLOW Extract DynamicData database tables.

b. Right-click on the ConfigDynamicDataField table and select Edit Top 200 Rows.

c. Add the field to the table and set IsDataCollectionEnabled to True.

d. Save your changes.
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3. Add the field to the Dynamic Learning field base.

a. Expand the Databases tree to display the eFLOW Extract DynamicLearning database tables.

b. Right-click on the ConfigDynamicLearningFieldBase table and select Edit Top 200 Rows.

c. Add the field to the table and set the following properties:

Property Value

ConfigDynamicLearning

DataType

The field's data type. This must be one of the values defined in the

ConfigDynamicLearningDataType table:

1: Amount

2: String

3: Number

4: Date

5: AmountDecimalOnly

Name Name of the field, for example, Ext_1.

IsRecognitionEnabled True

IsRequired False

LocalRectangle 150

Sequence Next highest number. For example, if the highest number in this

column is 20, set the value to 21.

ApplyValidation True

ApplyMasks False if the field is normalized (such as a date or amount),

otherwise True.

d. Save your changes.

e. Right-click on the ConfigDynamicLearningField table and select Edit Top 200 Rows.

f. Add a new record with the same field ID as the record you just added to the

ConfigDynamicLearningFieldBase table. Set the FirstPageOnly value to False.

g. Save your changes.
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4. Add the field to a group. Fields that are not part of a group cannot be dynamically learned. You should

always add a new group unless the field needs to have a connection to other fields in one of the existing

groups.

a. Right-click on the ConfigDynamicLearningBundleStatic table and select Edit Top 200 Rows.

b. Enter a Name for the group and set the properties.

Property Value

Name A name for the group, for example, CustomFields.

IsEnabled True

Sequence Next highest number. For example, if the highest number in this

column is 7, set the value to 8.

MaxSpace ...

FirstPageOnly False

c. Save your changes.

d. Right-click on the ManyToManyStaticBundleField table and select Edit Top 200 Rows.

e. Add a new record with the ID of your group and the ID of the field.

f. Save your changes.

Include the field in statistics
1. Open the StatisticsConfig.appconfig file in a text editor.

2. Add the field to the section <FieldStatistic><Fields>.

3. Save your changes.
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